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1 Grundlagen der Bedienung

1.1 Öffnen des Editors

Um ein Prozessmodell im  Rule Based Process Editor zu laden, muss im »AF-

ResourceNavigator«  des  AristaFlow  Process  Template  Editor mit  der  rechten 

Maustaste  auf  die  .template-Datei  des  Prozessmodells  geklickt  und im er-

scheinenden Menü Open With › Rule Based Process Editor ausgewählt wer-

den.

Es öffnet sich das gewählte Prozessmodell im Rule Based Process Editor.

1.2 Auswahl der Regeln

Nach dem Laden eines Modells im Editor ist die Menge der auszuwertenden 

Regeln leer.  Um eine Regel über dem Template auszuwerten, muss die ent-

sprechende, im SeaFlows-Regeleditor erzeugte .sgc-Datei in das Fenster »Result 

List« gezogen werden (Wird das Fenster nicht angezeigt, kann dies über Win-

dow › Show View › Other... durch Auswahl von Rule Support › Result List 

erreicht werden). Die Regeldatei wird dann der Menge der auszuwertenden 

Regeln hinzugefügt und automatisch ausgewertet.  Es können beliebig viele 

weitere Regeln hinzugefügt werden.



1.3 Auswahl der Regelklassen

Es werden nur die Regeln ausgewertet, für deren Regelklassen die Auswer-

tung aktiviert ist. Standardmäßig ist dies für alle Klassen der Fall. Um die aus-

zuwertenden  Regelklassen  zu  ändern,  kann  das  jeweiligen  Symbol  in  der 

Symbolleiste aktiviert/deaktiviert werden, wie im Folgenden dargestellt ist:

Hinweis: Die Schaltflächen können nur betätigt werden, wenn das Fenster des 

Rule Based Process Editor aktiv ist und nicht, wenn ein anderes Fenster, z.  B. die 

Übersichtsliste, aktiv ist.

Die einzelnen Regelklassen haben folgende Symbole und Bedeutungen:

 – Regeln, die auf keinen Fall verletzbar sein dürfen (Klasse 1)

 – Regeln, die bei der Ausführung nicht verletzt werden dürfen (Klasse 2)

 – Regeln, über deren Verletzung informiert wird (Klasse 3)

 – Regeln, die zur Laufzeit ignoriert werden (Klasse 4)

1.4 Funktionseinschränkungen des Editors

Leider sind im Rule Based Process Editor derzeit keine Bearbeitungen des Pro-

zessmodells  möglich.  Hierfür  muss  das  Prozessmodell  im  Standard-Editor 

von AristaFlow geöffnet werden (Auswahl bei rechter Maustaste auf die .tem-

plate-Datei) und nach Abschluss der Änderungen wieder im  Rule Based Pro-

cess Editor geladen werden.



2 Übersichtsliste

Die Übersichtsliste ist  im Fenster »Result List« enthalten.  Wird das Fenster 

nicht angezeigt, kann dies über Window › Show View › Other... durch Aus-

wahl von Rule Support › Result List erzwungen werden.

Die Übersichtsliste besitzt ein Menü, das verschiedene Einstellungen ermög-

licht. Um es zu erreichen, wird der Pfeil-Knopf ( ) in der rechten oberen Ecke 

des Fensters »Result List« verwendet.

2.1 Inhalt

Die Übersichtsliste enthält für jede Verletzung der zu untersuchenden Regeln 

im  Prozessmodell  einen  Eintrag.  Ebenfalls  werden,  je  nach  ausgewählter 

Gruppierung (siehe  folgender  Abschnitt),  auch  Gruppeneinträge  angezeigt, 

die die aggregierte Erfülltheit aller Regeln der jeweiligen Gruppe im Prozess-

modell angeben. In jedem Fall wird ein Eintrag »Alle Regeln« angezeigt, der 

die aggregierte Erfülltheit in allen dem Prozessmodell zugewiesenen Regeln 

anzeigt.

Um einen Überblick über alle dem Prozessmodell zugewiesenen Regeln zu er-

halten, muss nach Regeln gruppiert (siehe folgender Abschnitt) und im Menü 

der Übersichtsliste die Option »Auch erfüllte  Regeln anzeigen« ausgewählt 

sein.



2.2 Gruppierung und Sortierung

Es besteht die Möglichkeit, entweder alle Regelverletzungen als flache Liste 

darzustellen, oder sie nach verschiedenen Kriterien zu gruppieren. Gruppiert 

werden kann nach der verletzten Regel, der die verletzte Regel enthaltenden 

Datei sowie nach beidem. Hierzu wird im Übersichtslisten-Menü die entspre-

chende Gruppierung ausgewählt.

Um nach verschiedenen Kriterien zu sortieren, kann die entsprechende Spalte 

in der Übersichtsliste angeklickt werden. Ein erneuter Klick kehrt die Sortier-

reihenfolge um. Alternativ kann das Sortierkriterium im Menü der Übersichts-

liste ausgewählt werden. 

2.3 Regelverletzungen

Eine Regelverletzung wird mit dem Symbol gekennzeichnet, das der Regel-

klasse der verletzten Regel entspricht. Außerdem wird eine vereinfachte Be-

schreibung des verletzten Teils  der  Regel  dargestellt.  Wird die Regelverlet-

zung in der Liste angeklickt, wird sie zur genaueren Analyse in der Prozess-

darstellung angezeigt (vgl. Abschnitt 4.2).



2.4 Gruppeneinträge

Ein Eintrag für eine Gruppe enthält neben einer Beschreibung der Gruppe (je 

nach Gruppierungsart:  Name der  Regeldatei,  Beschreibung der  Regel  oder 

»Alle Regeln«)  eine Angabe der Erfülltheit der durch die Gruppe repräsen-

tierten Regeln im Prozessmodell. Diese Angabe erfolgt in Form eines Symbols 

und eines Beschreibungstexts (die Farbe des Symbols richtet sich dabei bei ei-

ner Gruppe, die eine einzelne Regel repräsentiert, nach deren Regelklasse):

 – Erfüllt, da Bedingungsteil in allen Ausführungsspuren verletzt

 – Erfüllt (in allen Ausführungsspuren)

 – Evtl. erfüllt (evtl. in allen Spuren erfüllt, evtl. nur in manchen)

 – Erfüllbar (aber erfüllende Ausführungsspuren nicht genau bekannt)

 – Erfüllbar (erfüllt in manchen, aber nicht allen Ausführungsspuren)

 – Evtl. verletzt (evtl. in manchen Spuren erfüllt, evtl. auch in keinen)

 – Verletzt (in keiner Ausführungsspur erfüllt)

 – Unbestimmt (keine Angabe möglich)

Wird einer oder mehrere Gruppeneinträge in der Liste ausgewählt, wird die 

Anzeige der  Erfülltheit  in der  Prozessdarstellung auf  die durch die  ausge-

wählten Gruppen repräsentierten Regeln eingeschränkt, also nur die Erfüllt-

heit dieser Regeln im Prozessmodell angezeigt.



3 Anpassung der Prozessdarstellung

3.1 Process Block Folding

Die Prozessdarstellung kann angepasst werden, um Prozessteile, die zum je-

weiligen Zeitpunkt nicht relevant sind, temporär zu einem einzigen Knoten 

zusammenzufassen. Werden im Prozess mehrere Knoten markiert, indem ein 

Rechteck  um sie  gezeichnet  wird,  werden automatisch  die  größtmöglichen 

komplett im Rechteck enthaltenen Blöcke bzw. Folgen von Blöcken mit jeweils 

einer Gruppierungs-Markierung umgeben, die einen Button enthält. Mit Hilfe 

dieses  Buttons  lässt  sich  der  ausgewählte  Bereich  dann zu einem einzigen 

Knoten zusammenfassen. Dieser Knoten enthält wiederum einen Button, mit 

dem er wieder »aufgeklappt« und der in ihm enthaltene Prozessteil angezeigt 

werden kann. Die Gruppierung bleibt dabei jedoch erhalten, damit man den 

Block später mit einem Klick auf den entsprechenden, in der Gruppierung ent-

haltenen Button wieder einklappen kann. Ein weiterer Button in der Gruppie-

rung ermöglicht, diese wieder vollständig aufzulösen.

 



3.2 Schleifenexpansion

Damit die Erfülltheit von Integritätsregeln im Prozessmodell bei der Ausfüh-

rung von Schleifen dargestellt werden kann, besteht die Möglichkeit, verschie-

dene Iterationen einer Schleife auszuwerten. In der standardmäßigen Darstel-

lung wird die  Erfülltheit  in  allen Ausführungsspuren dargestellt,  in  denen 

jede Schleife (soweit sie überhaupt ausgeführt wird) genau einmal ausgeführt 

wird. Um die Erfülltheit zu analysieren, wenn Schleifen mehrfach ausgewertet 

werden, kann die Schleifenexpansion eingesetzt werden.

Hierzu wird auf den »+«-Button geklickt, der sich am Schleifenendknoten je-

der im Prozessmodell vorkommenden Schleife befindet. Daraufhin wird der 

jeweiligen Schleife eine weitere Iteration hinzugefügt,  sodass die Erfülltheit 

der Regeln in dem Fall, dass die Schleife entsprechend wiederholt wird, unter-

sucht werden kann. Die Schleife kann beliebig oft expandiert werden.

Jede Iteration der Schleife außer der letzten wird mit einem Rahmen umgeben 

und einem Button versehen, mit dem sie eingeklappt werden kann, um Platz 

zu sparen.

Um eine Schleifenexpansion rückgängig zu machen, kann der »–«-Button ver-

wendet werden, der sich am vorletzten Endknoten der Schleife befindet.



4 Ergebnisdarstellung im Prozessmodell

Für die Darstellung der Ergebnisse im Prozessmodell existieren zwei Modi, 

der  Gesamterfülltheitsmodus und der  Regelverletzungsmodus.  Zu Beginn 

wird der Gesamterfülltheitsmodus angezeigt.

4.1 Gesamterfülltheitsmodus

Der Gesamterfülltheitsmodus erlaubt es, einen Überblick über die Erfülltheit 

der (in der Übersichtsliste ausgewählten) Regeln im Prozessmodell sowie die 

in diesen Regeln auftretenden Verletzungen zu erhalten.

Die allgemeine Erfülltheit der Regeln (»Gesamterfülltheit«) wird in Form von 

sog.  Spurlinien angezeigt. Standardmäßig werden hierdurch alle Spuren, in 

denen die Regeln erfüllt sind, dargestellt. Alternativ können auch die Spuren 

angezeigt werden, in denen nicht alle Regeln erfüllt sind (siehe Abschnitt 4.4). 

Wie  genau  eine  Spurlinie  eine  Menge  von  Ausführungsspuren  beschreibt, 

wird in Abschnitt 4.3 beschrieben.



Die Regelverletzungen werden dargestellt, indem alle Knoten, die für eine Re-

gelverletzung »verantwortlich« sind, durch ein Markierungssymbol, das dem 

Symbol  der  Regelklasse  der  verletzten  Regel  entspricht,  sowie  eine  Unter-

schlängelung der Knotenbeschriftung hervorgehoben werden. Bei einem Klick 

auf das Markierungssymbol wird eine Liste mit an dieser Stelle auftretenden 

Verletzungen angezeigt; bei Auswahl einer Regelverletzung in der Liste wird 

sie im Regelverletzungsmodus dargestellt.

4.2 Regelverletzungsmodus

Wird  eine  Regelverletzung  im  Gesamterfülltheitsmodus  oder  in  der  Über-

sichtsliste  ausgewählt,  wird  sie  im Regelverletzungsmodus  dargestellt.  Die 

Darstellung besteht aus drei Elementen: Spurlinien, einem Regelfragment und 

ggf.  einer Liste mit Alternativverletzungen. Die Spurlinien beschreiben eine 

Menge von Ausführungsspuren, in denen die Regelverletzung gilt, in denen 

also die Regel und der durch das Regelfragment angegebene Regelteil verletzt 

ist. Sie werden in  Abschnitt 4.3 genauer erläutert.

Das Regelfragment stellt dar, welcher Teil der Regel in welcher Weise von der 

ausgewählten Regelverletzung betroffen ist. Die Darstellung entspricht der in 

SeaFlows verwendeten Regelgraphdarstellung. Dabei ist zum einen der Bedin-

gungsteil der Regel angegeben, wobei die Occurrence-Knoten in den Prozess 

integriert dargestellt  werden. Dies zeigt,  unter welcher Bindung der Bedin-



gungsvariablen die Regelverletzung auftritt. Die anderen Knoten des Bedin-

gungsteils liegen als »freie« Knoten in einem eigenen Bereich über dem Pro-

zessmodell,  der verschoben werden kann.  Vom Folgeteil  wird nur der Teil 

dargestellt, der für diese Regelverletzung verletzt ist. Dies stellt eine Forde-

rung dar, die erfüllt werden muss, um die Regelverletzung zu beheben. Ab-

sence-Knoten  des  Folgeteils  können  ebenfalls  an  Prozessknoten  gebunden 

sein, was bedeutet, dass diese Knoten die Regel verletzen. Die anderen Knoten 

werden als »freie« Knoten im separaten Bereich dargestellt.

Bei Mausbewegung über einen »freien« Knoten des Regelfragments werden 

alle Knoten im Prozessmodell,  die dem Typ des Regelknotens entsprechen, 

farbig hervorgehoben, damit erkennbar wird, welche Knoten möglicherweise 

verschoben werden könnten, um die Forderung der Regel zu erfüllen. 

In der Liste mit Alternativverletzungen werden ggf. andere Regelverletzungen 

angezeigt, die statt der dargestellten Verletzung behoben werden können, um 

diese zumindest teilweise zu »heilen«. Bei Mausbewegung über eine solche 

Alternativverletzung wird diese temporär im Regelverletzungsmodus darge-

stellt, bei Klick auf sie wird die Darstellung fixiert.



4.3 Spurlinien

Eine Spurmenge wird durch einen Satz von Spurlinien dargestellt. Die Spurli-

nien geben an:

• Im Gesamterfülltheitsmodus: Die Menge der Spuren, in denen die aus-

gewerteten Regeln

◦ erfüllt sind – wenn die Spurlinien grün dargestellt sind

◦ nicht erfüllt sind – wenn die Spurlinien rot dargestellt sind

• Im Regelverletzungsmodus: Eine Menge von Spuren, in denen die aus-

gewählte Regelverletzung gilt.

Werden mehrere Spurlinien dargestellt, kann es schwierig sein, die einzelnen 

Linien zu verfolgen. Daher kann eine einzelne Spurlinie hervorgehoben wer-

den, indem die Maus über sie bewegt wird. Wird sie angeklickt,  bleibt die 

Hervorhebung bestehen, auch wenn die Maus wieder wegbewegt wird.

Eine Spurlinie kann Ausführungsspuren mit verschiedenem Verlauf beschrei-

ben, wenn sie sich an XOR-Verzweigungen in mehrere Linien aufspaltet. Bei 

einer AND-Verzweigung verzweigt sich eine Spurlinie immer in mehrere Lini-

en, da die Zweige ja parallel ausgeführt werden. Generell gilt: Die Spurlinie 

beschreibt alle Ausführungsspuren, bei denen die Knoten entlang eines Teils 

der Spurlinie ausgeführt werden.



Eventuell ist die Spurlinie auch eingeschränkt: Ist sie ganz oder teilweise ge-

strichelt (mit kleinem Strichabstand), heißt das, dass sie nur Ausführungsspu-

ren repräsentiert, in denen bestimmte Zusatzbedingungen gelten. Sind diese 

Bedingungen einfach,  werden sie  in Form von Pfeilen angezeigt,  wenn die 

Spurlinie ausgewählt ist: Ein Pfeil zwischen Knoten bedeutet, dass diese in der 

durch den Pfeil angegebenen Reihenfolge ausgeführt werden müssen. Ist am 

Pfeil eine Uhr angezeigt, gelten zusätzlich zeitliche Einschränkungen. Um die-

se anzuzeigen, kann die Maus über die Uhr bewegt werden.

Eventuell ist eine Spurlinie auch ganz oder teilweise mit größerem Strichab-

stand gestrichelt – dies bedeutet, dass das Ergebnis unscharf ist, also nicht ge-

nau  angegeben werden  kann,  ob  die  entsprechenden  Spuren in  der  Spur-

menge enthalten sind oder nicht.

4.4 Anpassung der Ergebnisdarstellung

Die Prozess- und Ergebnisdarstellung kann auf verschiedene Arten angepasst 

werden. Hierfür dienen die Schaltflächen in der Symbolleiste.

Mit  der  Schaltfläche   kann ausgewählt  werden,  ob  Spurlinien  angezeigt 

werden sollen oder nicht.  Werden Spurlinien angezeigt  und der Gesamter-

fülltheitsmodus ist aktiv, kann mit  und  umgeschaltet werden zwischen 

der Darstellung der Spuren, in denen die Regeln erfüllt sind und der Darstel-

lung derer, in denen sie verletzt sind.



Mit der Schaltfläche  kann das AutoFolding aktiviert und deaktiviert wer-

den. Ist es aktiviert, werden stets Blöcke, die für die aktuelle Ergebnisdarstel-

lung  nicht  relevant  sind,  automatisch  »eingeklappt«  und  wieder  »ausge-

klappt«, wenn sie relevante Elemente enthalten.

Mit  der  Schaltfläche   können  Animationen  aktiviert/deaktiviert  werden. 

Sind sie aktiviert, werden Änderungen in der Prozessdarstellung, etwa beim 

Ein-/Ausklappen von Blöcken oder der Schleifenexpansion, animiert. Es wird 

empfohlen, die Animationen nicht zu deaktivieren, da die Änderungen sonst 

abrupt erfolgen und hierdurch die Orientierung im Prozessmodell erschwert 

wird.

Mit den Schaltflächen   und   kann in die Prozessdarstellung vergrößert 

bzw.  verkleinert  werden.  Die  Schaltfläche   setzt  die  Darstellung auf  die 

Standardvergrößerung zurück.

Hinweis: Alle Schaltflächen können nur betätigt werden, wenn das Fenster 

des Rule Based Process Editor aktiv ist und nicht, wenn ein anderes Fenster, z.  B. 

die Übersichtsliste, aktiv ist.

Alle beschriebenen Funktionen sind auch über die Menüleiste erreichbar. Die 

Menüelemente sind ebenfalls nur verfügbar, wenn das Fenster des Rule Based  

Process Editor aktiv ist.



5 Anhang

5.1 Regeldateiformat

Das Dateiformat der Regeldateien entspricht dem der  .sfc-Dateien, die vom 

grafischen SeaFlows-Regeleditor erzeugt werden. Allerdings können sie für die 

bessere Verwendung im  Rule  Based Process Editor folgendermaßen erweitert 

werden:

• Das Element  de.seaflows.ss09.editor.model:IGraphicalRule kann um 

das Attribut description erweitert werden, in dem eine kurze Beschrei-

bung der Regel angegeben werden kann.

• Das Element  de.seaflows.ss09.editor.model:IGraphicalRule kann um 

das Feld ruleClass erweitert werden, das die Regelklasse in Form einer 

Zahl zwischen 0 und 3 angibt: Der Wert 0 entspricht Klasse 4, 3 ent-

spricht Klasse 1.

• In einer Regeldatei können innerhalb des Elements xmi:XMI mehrere 

Elemente  de.seaflows.ss09.editor.model:IGraphicalRule angegeben 

werden, die Regeldatei enthält dann mehrere Regeln. 
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